## Contents

What's New in SAS Task Manager 2.2 .................................................. vii

**Chapter 1 • SAS Task Manager** ......................................................... 1
  About SAS Task Manager ............................................................... 1

**Chapter 2 • SAS Task Manager Interface** ........................................... 5
  Log On to SAS Data Management Console ....................................... 5
  SAS Data Management Console Home Page ...................................... 6
  Specifying Your Preferences ........................................................... 7
  Overview of the SAS Task Manager Interface .................................... 11

**Chapter 3 • Understanding SAS Task Manager** ..................................... 13
  Working with SAS Task Manager ..................................................... 13
  SAS Task Manager Roles .................................................................. 19
  Deep Linking to Workflows in Task Manager ...................................... 20
  Logs ............................................................................................... 21

**Chapter 4 • Example** ........................................................................ 23
  Creating and Starting a Workflow ..................................................... 23

**Recommended Reading** ................................................................... 27

**Index** ............................................................................................... 29
What’s New

What’s New in SAS Task Manager 2.2

Overview

SAS Task Manager 2.2 has the following changes and enhancements:

- new preferences
- documentation enhancements

New Preferences

Four new user preference settings in SAS Task Manager enable users to perform the following tasks:

- show or hide the Activity ID and Workflow ID data objects
- show or hide all data objects that are normally controlled by the HIDE setting on data objects in the workflows themselves
- set the maximum number of workflows that are viewable in SAS Task Manager at one time
- control whether certain users, such as administrators, can see not only workflow tasks in which they are participants, but workflow tasks for all users of the system

These new preferences are associated with additional capabilities set by default for certain roles.

Documentation Enhancements

The SAS Task Manager content that was previously available in the SAS MDM: User’s Guide has been moved to this document.
Many organizations need to coordinate people, processes, and technology through defined business workflows. SAS Workflow Studio is a suite of applications and services that work together to meet these needs. It helps organizations model, automate, integrate, and streamline business processes. Several SAS solutions use SAS Workflow Studio to orchestrate user or system activity. SAS Task Manager is one of these applications. SAS Task Manager gives users direct access to a workflow that is initiated from one of the other SAS applications. With SAS Task Manager, users can start, stop, and transition workflows that have been uploaded to the SAS Workflow Studio server environment. SAS Task Manager also enables users to interact with certain elements of active workflows called data objects. These data objects can be used to trigger additional activity that goes beyond standard workflow interaction.

SAS Task Manager was designed for the following users:

<table>
<thead>
<tr>
<th>User</th>
<th>Privileges</th>
</tr>
</thead>
<tbody>
<tr>
<td>Administrators</td>
<td>Administrators can terminate active workflows or transition them to other users in case of errors or deadlocks.</td>
</tr>
<tr>
<td>Workflow template designers</td>
<td>Designers can test workflow behavior outside of the parent application that consumes the workflow definition.</td>
</tr>
</tbody>
</table>
Designated users can perform the following tasks:

- Start a workflow that acts as a scheduling process to initiate programs or web services in a defined way.
- Provide data input to workflow-backed processes through editable data objects in the workflow itself.
- Initiate or terminate project-based actions. Because users can start and stop workflows, they can control activities that tie into policies supported by the workflow design, including notifications, web service calls, scheduling a task, or invoking a SAS program.
- Interact with the workflow process through a custom form.

### Working with Data Objects

**Overview**

Two unique features make SAS Task Manager more than just a window to the SAS Workflow Studio environment:

- ability to add special attributes to workflow data objects
- ability to respond to particular data object sets in a workflow

### Adding Special Attributes to Workflow Data Objects

By default, data objects and their values are always shown to users in the Data tab, but they cannot be edited. By adding specific attributes to the data objects, users can hide data objects from view and make the values of certain data objects editable. Only the data objects short text, long text, number, and date are supported for editing. You can use the following attributes:

#### Table 1.2 Data Object Attributes

<table>
<thead>
<tr>
<th>Attribute</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>HIDE</td>
<td>Adding a HIDE attribute to a data object controls its visibility in SAS Task Manager. Setting it to 0 allows users to see the data object and value. Setting it to 1 hides the data object and value. By default, the data object and its value are displayed.</td>
</tr>
<tr>
<td>WRITE</td>
<td>Adding a WRITE attribute to a data object lets users edit the data object value in SAS Task Manager. Setting it to 0 sets the data object value to read-only. Setting it to 1 enables users to edit the value. By default, the data object value is read-only.</td>
</tr>
</tbody>
</table>

Other than the short text, long text, number, and date data objects, all other data object data type values are set to read-only by default, even if you set the WRITE attribute to 1. If you need to edit values other than the supported types,
use one of the supported types to capture the information. Then use data object substitution in the workflow design to transform the value to another type.

Note:
- Not all data types can be transformed into other data types without loss of information.
- Use all uppercase text for the HIDE and WRITE attributes.

Responding to Particular Data Object Sets in a Workflow

SAS Task Manager can respond to a particular set of data objects the workflow. This data object set, if found, instructs SAS Task Manager to present custom edit form capabilities to the user. The workflow might contain steps within which you want to present information to the user for modification, review, or approval. For each task in the workflow, you must add several data objects that indicate which plug-ins to use.

The following table describes the special set of data objects attached to each task in the workflow that present a customer edit form:

Table 1.3  Data Objects

<table>
<thead>
<tr>
<th>Task Data Object</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>UI_APP</td>
<td>Corresponds to the name of the application that is invoked.</td>
</tr>
<tr>
<td>UI_APPMODULE</td>
<td>Shows the location of the .swf file to load.</td>
</tr>
<tr>
<td>UI_ENABLED</td>
<td>Notifies SAS Task Manager to present the plug-in (0=No, 1=Yes).</td>
</tr>
<tr>
<td>UI_FORMID</td>
<td>Is an optional value to let the plug-in know what form to show to the user.</td>
</tr>
<tr>
<td>UI_KEY</td>
<td>Displays a value known by the plug-in and used to fetch the correct data row for display in the plug-in.</td>
</tr>
<tr>
<td>UI_SUBJECTAREA</td>
<td>Is an optional value known by the plug-in and typically used to help the plug-in find the correct external data to display.</td>
</tr>
<tr>
<td>UI_HOLD</td>
<td>Determines whether the action taken in the plug-in is a final action. The object commits a record to a target data source or is an action that saves the change in a temporary location (0=final save, 1=temporary save).</td>
</tr>
</tbody>
</table>

Other SAS applications or external applications must provide the specialized plug-in that can be invoked through these data objects. For example, SAS MDM provides a plug-in that allows editing of master data in the context of a workflow process.

In addition, special treatment is given to certain workflow data objects if they are found in your workflow templates:

BDN Term URL

If a valid URL that deep-links to a Business Data Network term ID is found in a data object with this name, a Link field appears in the workflow data panel.
Its value is a hyperlink labeled **Open Term**. When you click the link, the referenced term is opened in Business Data Network in a new browser tab.

**URL**

If a valid URL is found in a data object with this name, a **Link** field appears in the workflow data panel. Its value is a hyperlink labeled **Open in Application**. When you click the link, the referenced term is opened in the application that you specify. For example, you can deep-link into other applications like SAS MDM (see the *SAS MDM User’s Guide*) or SAS Data Remediation (see the *SAS Data Remediation User’s Guide*).
Log On to SAS Data Management Console

You can access SAS Task Manager through the standard logon window for SAS applications. This window opens SAS Data Management Console from which you can launch SAS Task Manager.

The port for all SAS Data Management web components is configured during installation. The default port number is 80. If your site is using the default port for these web components, you can access SAS Data Management Console from the following URL: http://hostname/SASDataManagement.

If your site is not using the default port for these web components, you must specify the port in the URL. For example, if the port is 7980, you can access SAS Data Management Console from the following URL: http://hostname:7980/SASDataManagement.

To log on to SAS Data Management Console:

1 Click the URL that is supplied by your system administrator, or paste it into the address field of your browser to display the SAS logon window:
2 In the **User ID** field, enter your user ID.

3 In the **Password** field, enter the password for your user ID.

   **Note:** Your password is case-sensitive. Your user ID might be case-sensitive, depending on the operating system that is used to host the web application server. If you need assistance, contact your system administrator.

4 Click **Log On** to display SAS Data Management Console.

   **Note:** If you log on to SAS Task Manager in one browser tab, and then log on to SAS Task Manager or a different SAS web application in another browser tab, the same credentials are used automatically for subsequent authentication attempts.

   To log off from SAS Data Management Console, click **Sign Out** in the upper right corner of the user interface:

   **Note:** When you select **Sign Out**, you are logged off from all tabs opened by SAS Management Console.

---

**SAS Data Management Console Home Page**

The SAS Data Management Console home page enables you to launch SAS Task Manager.

**Note:** The following image is an example. Your specific content might be different.
The File menu on the menu bar enables you to set preferences.

The Help menu enables you to access user’s guides and SAS on the web.

The TASK MANAGER portlet lists, and enables you to open, current task manager items.

The APPS listings link you to the component applications.

Note: The list of applications available to you varies according to your assigned role and to which SAS products you have installed.

---

Specifying Your Preferences

Specifying Global Preferences

You can specify global preferences to apply to all SAS web applications that are displayed with the Adobe Flash player. These preferences are set by each user.

To specify global preferences:

1. Select File ▶ Preferences to open the Preferences window.
2 Click **Global Preferences** in the left pane.

3 Select the **User locale** drop-down menu to specify your language and geographic region.

   Select the **Theme** drop-down menu to change the color scheme and other visual settings for all of your SAS web applications.

   Select the **Invert application colors** check box to invert all of the colors in your SAS web applications.

   Select the **Override settings for focus indicator** check box to change the color, thickness, and opacity of the focus in your SAS web applications.

4 Click **OK** to apply your changes.

5 Click **Reset to Defaults** to restore default settings.

**Note:** If you changed the **User locale**, then you must log off and log back on to SAS Task Manager for the change to take effect.

---

**Specifying SAS Task Manager Preferences**

To specify SAS Task Manager preferences:

1 Select **File** ▶️ **Preferences** to open the Preferences window.

2 Click **Task Manager** in the left pane.
Select the **Show workflow and activity IDs** check box to enable the display of workflow and activity IDs.

For every workflow task that has been started, you have the option to show or hide the Activity ID and Workflow ID values that are unique to every task. Having access to these identifiers is useful when referencing logs.

Select the **Show hidden data objects** check box to enable the display of hidden data objects.

Data objects are typically hidden in a workflow template. The HIDE option on data objects can be overridden globally by selecting the **Show hidden data objects** check box. This setting is useful for data stewards who want to validate the functioning of workflows.

**Note:** This option is controlled by a View All Hidden Data Objects capability set within the Task Manager: Task Administration role. If users are not members of a group that has been assigned this role or have not had this role explicitly assigned to them, they do not see this option in the SAS Task Manager preferences. This allows administrators to control the use of the **Show hidden data objects** feature if sensitive information is stored in workflow data objects.

Select a value in the **Maximum Number of Tasks to Display** field to change the number of workflows that are to be returned to the user in Task Manager. This control allows users to limit the number of workflows shown in the web application for cases where thousands of workflows have been initiated on the server. The default value is 500.
Click **OK** to apply your changes.

7 Click **Reset to Defaults** to restore default settings.

---

### Specifying SAS Data Management Console Preferences

To specify SAS Data Management Console preferences:

1. Select **File** ➤ **Preferences** to open the **Preferences** window.

2. Click **Data Management Console** in the left pane.

---

![SAS Data Management Console Preferences](image)

3. Specify the location of portlet panes that appear on SAS Data Management Console.

4. Click **OK** to apply your changes.

5. Click **Reset to Defaults** to restore default settings.
Overview of the SAS Task Manager Interface

Menu Options

The SAS Task Manager interface has several common features. The toolbars of the interface contain an Actions menu. Clicking displays the Actions menu and enables you to select specific options. Most options available from the Actions menu are also available through icons on the same toolbar. Holding the cursor over the icon displays the function of the icon. Clicking the icon performs the function.

You can click icons to expand and collapse elements of the interface. Click or to expand an item. Click or to collapse an item.

Tables

SAS Task Manager presents lists of workflows in a tabular form. These tables show a subset of the information associated with the workflows. All entries in a table are the same type of workflows. To open a workflow in an editor, double-click or right-click the row, and select Open or Edit from the pop-up menu.

**Figure 2.7  Sample Table**

<table>
<thead>
<tr>
<th>Name</th>
<th>Workflow Definition</th>
<th>Activity</th>
</tr>
</thead>
<tbody>
<tr>
<td>WILLIAM L PHILLIPS - INV...</td>
<td>MDM Tag</td>
<td>New Issue</td>
</tr>
<tr>
<td>WILLIAM L PHILLIPS - INV...</td>
<td>MDM Tag</td>
<td>Review Issue</td>
</tr>
<tr>
<td>巨世才 - INVALID OR MISSI...</td>
<td>MDM Tag Close Issue</td>
<td>New Issue</td>
</tr>
</tbody>
</table>

To open a workflow, you can do any of the following:

- Click from the toolbar.
- Click and select Open or Edit.
- Double-click a table row.
- Right-click a table row and select Open or Edit from the pop-up menu.

To sort a table column in either ascending or descending order, click the column heading. Sorted columns display up or down arrows to indicate the sort direction.
Understanding SAS Task Manager

Working with SAS Task Manager

Overview

SAS Task Manager provides a location to manage workflow instances that have been initiated in SAS Data Remediation, SAS MDM, or other external applications. For additional information, see the SAS Data Remediation User’s Guide or the SAS MDM User’s Guide.

SAS Task Manager displays a summary of information from external processes. Users can monitor and manage assignments for workflow tasks that are displayed in SAS Task Manager, correct the problems in an external system, and then close the issue within SAS Task Manager.

SAS Task Manager does not use a separate administration environment. SAS Task Manager relies on SAS Workflow Studio for workflow template design and management on the SAS Workflow server. For information about SAS Workflow Studio, see the SAS Workflow Studio: User’s Guide.

SAS Data Management Console Portlet

On the SAS Data Management Console, the Task Manager portlet displays an overview of tasks and a sampling of data:
Note: In the following descriptions, **Actions** menu items are accessed by clicking 📷. Some functions available from the **Actions** menu are also available from icons next to the **Actions** menu. Clicking the icon performs the function.

The top right area of the portlet contains an **Actions** menu with the following options:

**Display**
- enables you to check the number of items to display in the portlet. You can choose from 5, 10, 20, or 40 items.

**Refresh**
- refreshes the list of items in the portlet list.

  Note: The portlet does not refresh automatically. You must refresh it.

**Close the Portlet**
- closes the portlet on the SAS Data Management Console.

Note: For additional information about specifying portlet display preferences, see the *SAS MDM User’s Guide*.

When you click an item in the portlet list, the item opens in SAS Task Manager. You can also click **Task Manager** in the portlet or **Task Manager** under APPS to open SAS Task Manager.

SAS Task Manager is displayed in a new tab:
Depending on the permissions granted to you, can perform the following actions from the **SAS Task Manager** tab:

- Search for tasks based on different criteria.
- Edit and close tasks.
- Create new tasks.
- Terminate tasks.

The following sections describe these actions in detail.

**SAS Task Manager Tab**

**Quick Search**

When the SAS Task Manager tab opens, it displays a complete list of tasks. You can perform either a quick search or an advanced search to narrow this list to the tasks that you need to view.

To perform a quick search:

1. Enter the search term into the search field in the toolbar:
   
   ![Search Field](image)

   As you enter characters in the search field, the search automatically populates the task list with matching tasks.

2. Click to clear the search characters and restore the default task list.
**Advanced Search**

To perform an advanced search:

1. Click to display search criteria:

![Figure 3.2 Advanced Search Options](image)

   - As you specify any or all of the search criteria, the task list is modified accordingly.

2. You can do any of the following:
   - Click to expand all the search categories.
   - Click to collapse all the search categories.
   - Click to restore the search criteria to their default settings.
   - Click again to close search criteria.

   **Note:** To view the complete task list again, click to restore the search criteria to their default settings and restore the list.

**Managing Tasks**

The toolbar at the top of the task list contains an **Actions** menu with the following options:

**New Task**

creates a new task. You must have a role assignment that enables you to perform this action.
Open
opens the task selected in the task list and displays details about it in a new tab.

Terminate
removes the selected task from SAS Task Manager. You must have a role assignment that enables you to perform this action.

Details Pane
displays or hides details of the selected task in a separate pane.

Show All Tasks
appears if you are assigned the Task Manager: Task Administration role or are a member of the Data Management Administrators group. Selecting this shows all workflow tasks active in the system regardless of whether you are part of the workflow definition itself. You do not gain any extra privileges beyond those normally defined for a participant in the workflow. If you have permission to terminate tasks, you can terminate any workflow task visible due to the enabling of this feature.

In addition, if you are not defined as a user or group participant in an active workflow when this option is selected, the Data tab in the details pane does not appear nor does the toolbar containing actions buttons that were derived from the workflow definition.

Refresh
refreshes the task list.

About SAS Task Manager
displays application version information.

The details pane at the bottom of the tab contains two sub-tabs: Task Details and Task Data. The Task Details tab is displayed by default. For detailed information about the fields on these tabs, see the Task tab description.

Action buttons might appear below the Task Details and Task Data sub-tabs. These are determined by the workflow definition and might not be a part of your template.

**Task Tab**

When you select a task from the task list and click Open, the task opens in a new tab.
The toolbar contains an **Actions** menu with the following options:

**Terminate**
terminates the workflow on the server and removes the selected task from SAS Task Manager. You must have a role assignment that enables you to perform this action.

**Refresh**
refreshes the task list.

Action buttons might appear in the toolbar. These are determined by the workflow definition and might not be a part of your template.

The **Task Details** and **Task Data** panes are comparable to the **Task Details** and **Task Data** sub-tabs on the SAS Task Manager tab.

The **Task Details** pane provides an overview of information related to the selected task:

**Name**
the name of the selected task.

**Workflow definition**
the name of the workflow template used for the selected task.

**Activity**
a value that comes from the workflow definition. It is the current step in the workflow. When you change a status, the **Activity** state changes depending on the design of the workflow.

**Assignee**
the user or users assigned to the selected task.

**Start date**
the date on which the workflow was started.
**Activity ID**
Identification defined in SAS Workflow Studio. This only appears if the corresponding SAS Task Manager user preference has been selected to show IDs. For details, see “Activity ID” on page 19.

**Workflow ID**
Identification defined in SAS Workflow Studio. This only appears if the corresponding SAS Task Manager user preference has been selected to show IDs. For details, see “Workflow ID” on page 19.

The values that are displayed on the Data pane depend on the design of your workflow template. The information under **Task Data** comes from the data objects in the workflow definition. You can control the visibility and editability of the data object values by setting certain attributes on the data objects through SAS Workflow Studio. For more information, see “About SAS Task Manager” on page 1.

If you add or edit values in data object fields that are editable, they are passed into the next step of the workflow when you use one of the copy data object policies available on the task.

The following data object values are always provided by the workflow engine:

**Process Invoker**
the user that sent the task to SAS Task Manager.

**Process Title**
the name used in SAS Data Remediation for the selected task.

Some steps in the workflow provide a specific interface for user interaction. For example, if the workflow template is so designed, then SAS Task Manager can interact with SAS MDM. In Figure 3.3, this appears as the SAS MDM: Actions pane. The fields displayed in this pane depend on your data source and are shown here only as examples.

After you have reached a terminal step in the workflow, the task no longer appears in SAS Task Manager.

---

**SAS Task Manager Roles**

SAS Task Manager creates three new roles in SAS Management Console. These roles are tied to distinct capabilities in the task management application. Depending on the assigned role of the user, the experience in SAS Task Manager changes. Certain features are available to those assigned one role, but the same features are not available to users in another role.

Here are the roles for SAS Task Manager:
Table 3.1  SAS Task Manager Roles

<table>
<thead>
<tr>
<th>Role</th>
<th>Default Groups</th>
<th>Capability</th>
</tr>
</thead>
</table>
| Task Manager: Task Administration | Data Management Administrators | ■ View Application: The user can view a workflow in SAS Task Manager.  
■ Manage Tasks: The user can edit set workflow statuses and edit data object values (if they are set to be editable).  
■ Initiate Tasks: The user can start a workflow.  
■ Terminate Tasks: The user can cancel active a workflow.  
■ View all Tasks: the user can see workflows in which they are not defined as participants. This enables the Actions menu option View All Tasks.  
■ View All Data Objects: the user can override the HIDE option specified on data objects in a given workflow and thereby view the data values for all data objects in an active workflow. |
| Task Manager: Task Management  | Data Management Stewards, Data Management Business Approvers | ■ View Application: The user can view a workflow in SAS Task Manager.  
■ Manage Tasks: The user can edit set workflow statuses and edit data object values (if they are set to be editable).  
■ Initiate Tasks: The user can start a workflow. |
| Task Manager: Task View       | Data Management Business Users   | ■ View Application: The user can view a workflow in SAS Task Manager. |

Deep Linking to Workflows in Task Manager

Deep linking refers to constructing a URL hyperlink that, once initiated, can take a user directly to a named workflow instance in SAS Task Manager rather than requiring the user to search for it. For example, a workflow can send a URL link in an e-mail to a user. When the user clicks the URL link, it opens the SAS Task Manager application and loads the specific workflow instance encoded in the URL.

From within the appropriate environment, create a URL using the following syntax:

http://<your_host>/SASDataManagement/
#workflowID=<workflow_instance_ID>&module=TASKMANAGER

For example, you might create the following:
Logs

Logs for SAS Task Manager can be found on the application server that hosts it. They are typically found in a location similar to the following:

SAS Task Manager

..\Config\Lev1\Web\Logs\SAServer13_1\SASTaskManager.log

Other logs that might be useful for troubleshooting might not be on the same system as SAS Task Manager. Examples are as follows:

SAS Workflow

..\Config\Lev1\Web\Logs\SAServer1_1\SASWorkflowServicesx.x.log

SAS Metadata Server

..\Config\Lev1\SASMeta\MetadataServer\Logs
Example

Creating and Starting a Workflow

Overview

The primary purpose of SAS Task Manager is to view workflow instances that have been initiated by another SAS application such as SAS Data Remediation or SAS Business Data Network. However, it is also possible to initiate a workflow instance directly from SAS Task Manager and interact with it. The following simple example shows how this can be done.

Creating a Workflow Template in SAS Workflow Studio

Using SAS Workflow Studio, you can create a workflow template that can be started from SAS Task Manager, can accept data values from the user, and can be transitioned to a Done state to complete the workflow.

Figure 4.1   Workflow Template

To create the workflow template in SAS Workflow Studio:

1. Create a new workflow template named Example.
2. Create two tasks and define these tasks as Start and End.
For each task, create a data object. For the Start task, name the data object MessageIn and for the End task, name the data object MessageOut. Use the short text data type for both data objects and add the following attributes:

\[
\begin{align*}
\text{HIDE} & = 0 \\
\text{WRITE} & = 1
\end{align*}
\]

This enables these data objects be visible and editable in SAS Task Manager.

To pass data values from one object to another, add a new Policy on the Start task that copies the data object value from MessageIn to MessageOut with the event type of Task Finished. This enables you to edit the data value first and have it passed over to another data object once the status has been modified.

Add Data Management Stewards as a group participant on both the Start and End tasks.

Add a Confirm status and set it for the transition between the Start and End tasks.

Add a Done status and set it as the transition between the End task and the terminating task represented by "x".

Upload this workflow template to the SAS server. Log on to the SAS Server from the main menu and save this new workflow to the online repository, activating it before you complete the transaction.

You now have a workflow template that enables any user in the Data Management Stewards group to invoke it, start a workflow, add a message to it, and mark it complete. In a more elaborate scenario, this same design might include a new Invoke Web Service policy that takes the input from the data steward, passes it into the web service, and sends an e-mail confirmation to the data steward when the web service successfully completes.

**Starting a Workflow in SAS Task Manager**

If you are a member of the Data Management Stewards group, you can now log on to SAS Task Manager and start the workflow.

To start the workflow in SAS Task Manager:

1. From the **Actions** menu, select **New Task** to open the New Task dialog box.
2. In the New Task dialog box, select the **Example** template that you created and enter a name. Click **OK**.
3. The workflow begins and a new workflow instance appears in the table of tasks. **Confirm** appears beneath the **Task Details** and **Task Data** tabs.
4. Click the **Task Data** tab and enter text in to the **MessageIn** data field. Click **Confirm**.

The workflow moves from the Start task to the End task shown in the main workflow queue. **Done** appears in the issue toolbar as well as the data that you entered into the MessageIn data object appearing in a new MessageOut data object.
5 Click **Done**. This terminates the workflow because the next step in the workflow definition is the standard termination task.

You have learned how to create a new workflow with tasks, statuses, and data objects. You have added participants, connected to the workflow server, and uploaded a new workflow. Also, you have learned how these design decisions appear in SAS Task Manager. Much more elaborate workflows are possible and are common, but they all share the same basic building blocks and are represented in the same manner in SAS Task Manager.
Recommended Reading

- DataFlux Data Management Studio Installation and Configuration Guide
- DataFlux Data Management Studio User’s Guide
- DataFlux Data Management Server Administrator’s Guide
- DataFlux Data Management Server Users’s Guide
- SAS Workflow Studio User’s Guide
- SAS Intelligence Platform Middle-Tier Administration Guide
- SAS Management Console User’s Guide
- SAS MDM User’s Guide
- SAS Data Remediation User’s Guide

For a complete list of SAS books, go to support.sas.com/bookstore. If you have questions about which titles you need, please contact a SAS Book Sales Representative:

SAS Books
SAS Campus Drive
Cary, NC 27513-2414
Phone: 1-800-727-3228
Fax: 1-919-677-8166
E-mail: sasbook@sas.com
Web address: support.sas.com/bookstore
Index

**D**
data objects
  - adding special attributes 2
  - overview 2
  - responding to particular data object sets 3

**P**
preferences
  - global 7
  - SAS Data Management Console 10
  - SAS Task Manager 8

**S**
SAS Data Management Console
  - home page 6
  - log on 5
  - preferences 10
SAS Task Manager
  - interface 11
  - managing tasks 16
  - overview 1, 13
  - portlet 13
  - preferences 8
  - roles 19
  - searches 15
  - users 1

**W**
workflow, example 23

**E**
example, workflow 23

**G**
global preferences 7

**H**
home page, SAS Data Management Console 6

**I**
interface, SAS Task Manager 11

**L**
log on, SAS Data Management Console 5
Gain Greater Insight into Your SAS® Software with SAS Books.

Discover all that you need on your journey to knowledge and empowerment.

support.sas.com/bookstore for additional books and resources.